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Notice and Disclaimer 
This manual’s sole purpose is to assist installers and/or users in the safe and 
efficient installation and usage of the system and/or product described herein. 

BEFORE ATTEMPTING TO INSTALL AND/OR USE THE SYSTEM, THE INSTALLER AND 

THE USER MUST READ THIS MANUAL AND BECOME FAMILIAR WITH ALL SAFETY 

REQUIREMENTS AND OPERATING PROCEDURES. 
 The system must not be used for purposes other than those for which it 

was designed. 

 The use of the software associated with the system and/or product, if 
applicable, is subject to the terms of the license provided as part of the 
purchase documents. 

 ROSSLARE exclusive warranty and liability is limited to the warranty and 
liability statement provided in an appendix at the end of this document. 

 This manual describes the maximum configuration of the system with the 
maximum number of functions, including future options. Therefore, not 
all functions described in this manual may be available in the specific 
system and/or product configuration you purchased. 

 Incorrect operation or installation, or failure of the user to effectively 
maintain the system, relieves the manufacturer (and seller) from all or any 
responsibility for consequent noncompliance, damage, or injury. 

 The text, images and graphics contained in the manual are for the 
purpose of illustration and reference only. 

 All data contained herein is subject to change without prior notice. 

 In no event shall manufacturer be liable for any special, direct, indirect, 
incidental, consequential, exemplary or punitive damages (including, 
without limitation, any and all damages from business interruption, loss of 
profits or revenue, cost of capital or loss of use of any property or capital 
or injury). 

 All graphics in this manual are for reference only, some deviation between 
the image(s) and the actual product may occur. 

 All wiring diagrams are intended for reference only, the photograph or 
graphic of the PCB(s) are intended for clearer illustration and 
understanding of the product and may differ from the actual PCB(s).
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1. Introduction 
Rosslare's CP-R20U is a desktop card programmer for 125 KHz ISO and 
Clamshell RFID proximity cards. 

The CP-R20U makes managing re-programmable cards easier and can help 
facilitate the effective deployment and control of any Facility code application, 
including access control, intrusion, and Time and Attendance applications. 

1.1 The CP-R20U System 

The CP-R20U is built for high-security, portability and ease of use, enabling 
high quality RFID proximity card reading and writing at a low cost. 

The CP-R20U programmer is controlled by computer using Rosslare's CP-R20U 
Proximity Cards Programmer software package. 

1.1.1 Desktop Convenience 

The CP-R20U is small and lightweight, with a slim and attractive design. It is 
built for convenience and portability, with a USB 1.1 computer interface that 
makes it quick to install and allows it to run without any additional power 
source. 

Designed to sit safely on any desktop, the CP-R20U is sturdily built, with a 
large ergonomic tray for Clamshell or ISO cards and surface-gripping rubber 
feet. 

1.1.2 Intuitive Software System 

The CP-R20U Proximity Cards Programmer software package operates on 
almost all standard PCs. 

The system allows you to maintain your customer database quickly and easily. 
Because every card is tracked separately within the database, the system will 
not program duplicate cards, and the user can monitor the status of all 
assigned cards. 

Every card batch requires a unique Job Order code. This ensures that any card 
that the CP-R20U has programmed can be tracked, making unauthorized use 
of the programmer easy to detect. The system also includes a security 
authentication system and a real-time operations log. 

1.1.3 Compatibility 

CP-R20U is compatible with the AC-215 Access Controller and AS-215 Access 
Control software. 

For best performance we recommend always using Rosslare accessories. 

1.2 Main Features 

The CP-R20U is a feature-rich RFID proximity card programmer, ideal for all 
Facility code applications in access control, intrusion, and Time and Attendance 
applications. 
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1.2.1 CP-R20U Programmer 

 Allows the user to read, verify, and program RFID proximity cards 

 Supports serial and USB 1.1 computer connections 

 LEDs and buzzer system indicate programming status, card status, and 
power supply 

 CP-R20U runs a thorough internal diagnostic self-test every time it turns 
on 

1.2.2 Proximity Cards Programmer Software 

 All card details are automatically saved within the system database, 
ensuring complete card security 

 Monitor card use and replace damaged or lost cards instantly 

 Print detailed customer log files 

 Create many job orders for each customer listed in the database 

 Prevents the accidental re-use any unique card number 
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2. CP-R20U Hardware Specifications 

Physical Data 
Dimensions 
(L x W x H) 

150 x 120 x 30 mm (5.9 x 4.7 x 1.2 in.) 

Weight 150 g (5.29 oz) 

Electrical Specifications 
Power Consumption Typical: 35 – 70 mA (maximum: 100 mA) 

Operating Voltage 12 VDC Via USB 

Input Current Standby: 20 mA 

Maximum: 45 mA 

Environmental Data 
Operating Temperature Range 10º to 50º C (50º to 122º F) 

Operating Humidity 0 to 95% (non-condensing) 

Data Specifications 
Data format EM4002, Rosslare data format 

Cards Atmel 555x series, Sokymat 

RF Frequency 125 KHz @ ASK modulation 

RF Transmission Time 50ms 

Software Requirements 
Operating System Windows /98/NT/ME/2000/XP/7 

Processor At least Pentium 133 MHz 

Memory At least 16MB 

Connection Port USB 
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Standards Approvals 
US Standards Compliance 

Radio Frequency Compliance FCC Part 15b (U.S. Standard) 

EU Standards Compliance 

EMC Emission EN 50081-1 1992 

EMC Immunity EN50082-1 1997 

EMC Immunity to Conducted RF EN6100-4-6 1996 

R&TTE requirements 

(Directive 1999/5/EC of the European 
Parliament and of the Council of March 
1999) 

EN55022 1998 

RFI EN55022 1998 

Safety EN60950+Am1(93), Am2(93), Am3(95), 
Am4(97) 
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3. Installation 
3.1 Unpacking the Equipment 

The CP-R20U programmer is ready to use immediately "out of the box" and 
includes sample OTP and MTP Cards, USB cable and documentation. 

Please confirm you have received all the items listed below before you begin. If 
you find any items missing, contact your dealer immediately. 

 One CP-R20U RFID card programmer 

 One Male A to Male B USB cable 

 One software CD 

 One multi-programmable MTP Card Temic 5557 

 One one-time programmable OTP card 

 Two inlay keyboard templates 

 Instruction manual 

The standard CP-R20U pack contents are listed. Additional components can be 
ordered separately. Contact your dealer for more information. 

3.2 Installing the CP-R20U Software 

The CP-R20U Proximity Cards Programmer software is included on a CD-ROM 
with the CP-R20U. 

To install the CP-R20U software for the first time: 
1. Insert the CD into your computer's CD drive. 

2. Open My Computer, double-click on the CD drive icon, and then double-
click the CP-R20.exe file. 

The Welcome to CP-R20U Setup window appears. 
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3. Click Next. 

4. Follow the InstallShield's on-screen instructions. For a standard 
installation, click Next at every stage. 

5. On reaching the InstallShield Wizard Complete window, click Finish to 
end the installation process. Restart the computer if requested. 

3.3 Connecting the CP-R20U to a Computer 

Once the software has been installed, the CP-R20U unit can be connected to 
the computer. 

 

Do not connect the CP-R20U to the computer until you have installed the CP-
R20U software (see Section  3.2). 

3.3.1 Attaching the USB Cable 

Insert the USB cable into the CP-R20U communication socket at the back of 
the machine (Figure 1). 

Figure 1: CP-R20U Communication Port 

 
3.3.2 Installing the CP-R20U USB Driver 

Before the CP-R20U can be used with a USB connection for the first time, the 
USB driver must be installed on the computer. 

To install the CP-R20U USB driver: 
1. Connect the USB cable to the CP-R20U and to the computer. 

Microsoft Windows® automatically opens the Found New Hardware 
Wizard. 
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2. Select Install from a list or specific location (Advanced), and click 
Next. 

The Search and Installation Options window opens. 

 
3. Select Search for the best drivers in these locations and check the 

Include this location in the search box. 

4. Click Next. 

The installation process begins. 
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5. During the installation process, Windows may display a Windows Logo 
testing message. Click Continue Anyway. 

 
6. Follow the on-screen instructions until the Files Needed window opens. 

 
7. Click Browse to select the folder where you installed the CP-R20 

software. 

By default, the software is installed in "C:\Program Files\Rosslare\CP-R20". 

Click OK. 

The Completing the Found New Hardware Wizard window opens. 
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8. Click Finish. 

The CP-R20U driver is now fully installed on the computer. 
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4. The CP-R20U Software 
4.1 Starting the Software 

This section explains how to start the software and log in to the main window. 

To start the software: 
1. Click on the CP-R20 icon on the desktop, or select the program from the 

Rosslare folder in the "Start" menu. 

 
The Login dialog appears. 

 
2. Enter a password. The default password is "admin". 

The main window of the CP-R20U software opens. 

4.2 Software Overview 

The main window of the CP-R20U software allows users to: 

 Update and maintain the card database 

 Specify the type of cards to be programmed 

 Read information from cards placed on the CP-R20U 

 Program cards on the CP-R20U 
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Figure 2: CP-R20U Proximity Cards Programmer Main Window 

 
The central features of the CP-R20U software window are: 

Table 1: Central Features 

1 Name Lists all the Customers currently in the system's database. 

2 Job Order Lists all Job Orders currently in the system's database. 

A Job Order is a set of Cards assigned to a Customer. All 
the cards in a Job Order share the same card format. 

3 Cards Quantity The total number of cards within the selected Job Order. 

4 Port Status A green circle indicates the CP-R20U is connected to the 
computer. If the circle is red, check the connection 
between the CP-R20U and the computer. 

5 Toolbar Use the toolbar icons to perform all the software's basic 
tasks (see Section  4.2.1). 

6 Cards Counter The number of cards within the selected Job Order that 
have been programmed and verified. 

7 Card Properties Shows the card type, Wiegand format and the available 
card action types. 

Card action types can only be set for cards in a Wiegand 
RFR format. 

When you select a Job Order, the card type and Wiegand 
format are set as part of that Job Order and cannot be 
modified from these boxes. 
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8 Card Code Shows the card's Customer code, Facility Code and ID 
Number. 

The Customer Code can only be set for cards in a 
Wiegand RFR format. 

When a Job Order has been selected, the Facility Code 
and ID Number are set as part of that Job Order and 
cannot be modified from these boxes. 

Each ID Numbers is unique and cannot be used twice 
within a single Customer's card set. 

9 Display Area Lists details of all programmed and verified card currently 
selected. 

10 Time and Date The current time and date set on the computer. The 
database records a timestamp for all card operations 
performed. 

4.2.1 Using the Toolbar 

The toolbar controls all the basic tasks required to program and manage your 
cards. 

The toolbar icons are dynamic and change according to the actions performed. 
Table 2: Toolbar Icons 

Icon Name Description 

 

Program icon 
 

Program the card currently in the CP-R20U, according to 
the selected Job Order or card settings. 

 

Read icon 
 

Read data from the card currently in the CP-R20U. The 
information is shown in the software's display area. 

 

Verify icon 
 

Read data from the card currently in the CP-R20U and 
compare it with the selected Job Order or card settings. 

 

Delete icon 
 

Delete the current customer and Job Order details from 
the system database. 

 

Print icon 
 

Print the current data shown in the display area. 

 

Exit icon 
 

Exit the Proximity Cards Programmer. 
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4.2.2 Using the Menu Bar 

The menu bar controls the general operations and setup of the software. 
Table 3: Menu Bar 

Menu Description 
File > Exit Closes the application. 

Tools > Settings Opens the Settings window, allowing the user to change the 
password and set connection preferences. 

Help > About Software version information. 

Help > User Guide Opens this user guide in PDF format 
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5. How to Program a Card 
This section explains the step-by-step process required to program a card using 
the CP-R20U. 

Step Action Section 

 
Connect the computer to the CP-R20U 

 5.1 

 
Check the connection 

 5.2 

 
Create a Customer 

 5.3 

 
Set-up a Job Order 

 5.4 

 
Program the cards 

 5.5 

 

5.1 Connecting the CP-R20U 

The CP-R20U connects to any standard computer using the supplied Male A to 
Male B cable. For more information, see Section  3.3. 

To connect the CP-R20U to the computer: 
1. Connect the USB cable to the computer and then to the CP-R20U. 

2. Open the software and select Settings from the Tools menu. 

The Settings window appears. 
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3. Select to connect by USB and click OK. 

In the main window, the Port Status icon should be green and read "USB 
Open. 

5.2 Checking the Connection to the Computer 

Before beginning to program cards, check that there is a working connection 
between the CP-R20U and the computer. 

To check the CP-R20U connection to the computer: 
1. Put a programmed card or a card with a pre-set serial number on the CP-

R20U tray. 

2. Open the software and select "Test" from the Name box. 

Click on the toolbar Read icon. 

The system displays a "Read – succeed" message if the CP-R20U is 
properly connected. 

If the system displays the message "Failed to read card!" check your 
connections, restart your computer and try again. 

 

For assistance, contact Rosslare technical support. 

5.3 Creating a New Customer 

The software database tracks which cards were created for which customer. 
One or more customers must exist before it is possible to program a card. 

To enter a new customer into the database: 
1. Click New opposite the Name box. 

The New Customer window opens. 

 
2. Enter a customer name and click OK. 

5.4 Setting Up a Job Order 

Using a Job Order, it is possible to program many cards for one customer in a 
single session. 

To set up a new Job Order: 
1. Select a Customer from the Name box. The new Job Order is assigned to 

this Customer. 
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2. Click New opposite Job order. 

The New Job Order window opens. 

 
3. Enter a Job Order name and select a card type and card format. 

4. Fill other fields as required and click OK. 

5.5 Programming the Cards 

Once the CP-R20U is properly connected to the computer and the customer's 
Job Order has been set up within the system, it is possible to program the 
cards. 

To program cards on the CP-R20U: 
1. Select a Customer Name and Job Order from the Name and the Job 

Order boxes. 

2. Place a card on the CP-R20U tray. 
Figure 3: Programming a Card 
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3. In the software, click the toolbar Program icon. 

4. If the Job Order is for more than one card, repeat Steps  2 and  3 until 
every card has been programmed. 

The number in the Cards Counter box increases, showing how many 
cards in the Job Order have been programmed and verified. 

 

The CP-R20U may corrupt cards that are left too close. 
Keep all blank and programmed cards at least 20 centimeters away from the 
CP-R20U at all times. 

 



System Maintenance 

CP-R20U Hardware and Software User Manual  25 

A. System Maintenance 
To maximize the lifetime of your product, we recommend that you follow 
these guidelines as closely as possible: 

 Do not expose the unit to water, rain, or to humidity over the specified 
level. 

 Do not expose the unit to direct sunlight for extended periods. This can 
cause overheating and system failure. 

 Avoid dropping the unit onto the ground. This may cause 
electromechanical failure. 
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B. Limited Warranty 
The full ROSSLARE Limited Warranty Statement is available in the Quick Links 
section on the ROSSLARE website at www.rosslaresecurity.com. 

Rosslare considers any use of this product as agreement to the Warranty Terms 
even if you do not review them. 

http://www.rosslaresecurity.com/
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Latin America 
Rosslare Latin America 
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China 
Rosslare Electronics (Shenzhen) Ltd. 
Shenzhen, China 
Tel: +86-755-8610-6842 
Fax: +86-755-8610-6101 
support.cn@rosslaresecurity.com 
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Rosslare Electronics India Pvt Ltd. 
Tel/Fax: +91-20-40147830 
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07

06
-0

96
03

16
+

01
 


	1. Introduction
	1.1 The CP-R20U System
	1.1.1 Desktop Convenience
	1.1.2 Intuitive Software System
	1.1.3 Compatibility

	1.2 Main Features
	1.2.1 CP-R20U Programmer
	1.2.2 Proximity Cards Programmer Software


	2. CP-R20U Hardware Specifications
	3. Installation
	3.1 Unpacking the Equipment
	3.2 Installing the CP-R20U Software
	3.3 Connecting the CP-R20U to a Computer
	3.3.1 Attaching the USB Cable
	3.3.2 Installing the CP-R20U USB Driver


	4. The CP-R20U Software
	4.1 Starting the Software
	4.2 Software Overview
	4.2.1 Using the Toolbar
	4.2.2 Using the Menu Bar


	5. How to Program a Card
	5.1 Connecting the CP-R20U
	5.2 Checking the Connection to the Computer
	5.3 Creating a New Customer
	5.4 Setting Up a Job Order
	5.5 Programming the Cards

	A. System Maintenance
	B. Limited Warranty

